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SAS Enterprise Guide ® and SAS ®: WORK-ing together 

Bruce Albritton, Bruce Albritton Inc. 

ABSTRACT 
 
Enterprise Guide and regular SAS users are often two distinct groups. This discussion tries to widen the slice of the 
Venn diagram representing users of both products. It presents a way to look at a regular SAS session's WORK 
directory from Enterprise Guide, and vice versa. There are often times when it would be helpful for an experienced 
SAS user to hop over to Enterprise Guide for a quick second to say, look at a SAS data set in Microsoft Excel (a four-
click process once an Enterprise Guide local server is running). Another example would be to see quickly how 
different formats look on a data value, or perhaps how Enterprise Guide would write a piece of code for a task. 
Enterprise Guide can quickly build Structured Query Language (SQL) code - not always a strong suite of traditional 
SAS users. Going the other way, perhaps an experienced Enterprise Guide user would like to see the SAS program 
(or many SAS programs), the SAS log, and the Output windows simultaneously, or would like to see the results of 
one run alongside the results of a subsequent run. This can be especially helpful in teaching/learning situations. 
Instead of a best-of-breed philosophy between vendors, this is a best-of-breed discussion within a vendor, using each 
product, Enterprise Guide and regular SAS, for the things each does best. Apologies are given up front for the 
amount of time spent during setup. Hopefully, the result will be worth it. 

INTRODUCTION 
 
But before the fun, some WORK (pardon the pun) needs to be done. To look at the WORK directories of regular SAS 
and Enterprise Guide from each other’s user interface, two prerequisite topics – each valuable knowledge on their 
own - are required: 

 Change the default location of the WORK directory 
 Edit or create autoexec programs for regular SAS and Enterprise Guide that: 

o Implement the ‘x’ command to shell out of regular SAS and Enterprise Guide 
o Dynamically build another SAS program (one line of code) that gets read in and run automatically 

 
Although these advanced topics are challenging, thankfully they are one-time tasks and are explained fully below. 
Stick with it. Everything gets easy once this setup is complete. Then as mentioned, a SAS data set can be viewed in 
Microsoft Excel in four clicks. Different formats can be tried out on different data values. Structured Query Language 
(SQL) code can be built for a WORK data set almost magically. And, the three most used windows in SAS can be 
viewed simultaneously. 
 
These changes are meant to be made on a laptop or desktop machine used by one person. They apply to SAS and 
Enterprise Guide running locally on Microsoft Windows, where Enterprise Guide utilizes the local SAS server. Close 
all SAS products running on the machine before beginning these changes. Note, many of these changes are 
permanent changes. It is always a good idea to know how to back them out. 

CHANGE THE DEFAULT LOCATION THE WORK DIRECTORY 
 
Always back up the SAS configuration file before making any changes to it, and always test the changes before using 
any SAS product for development or production. To find out where the SAS configuration file is located, right-click on 
the SAS icon on the desktop or under All Programs, SAS, and click on Properties. Search through the Target box 
until the text SASv9.CFG is found. A typical path is ‘C:\Program Files\SASHome\SASFoundation\9.3\nls\en\ 
sasv9.cfg.’
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From the Start Menu go to All Programs, Accessories, and right-click on Command Prompt, then choose Run as 
Administrator. Enter an Administrator’s login credentials. Navigate to the directory containing SASv9.CFG by utilizing 
the CD command (e.g. cd \Program Files\SASHome\SASFoundation\9.3\nls\en). Quotes are not needed 
with the CD command. Change directories one at a time if typing is a problem. 
 
Make sure no SAS product is running. Once in directory EN, use the COPY command to make a backup copy of 
SASv9.CFG (e.g. COPY SASv9.CFG SASV9_BAK.CFG). Type NOTEPAD SASv9.CFG to edit it in Microsoft 
Notepad (do not use SAS or Enterprise Guide to edit SASv9.CFG). 
 
Go down below the ‘DO NOT EDIT BELOW THIS LINE’ line towards the bottom to the line containing the WORK 
parameter. Comment out the WORK line using the normal SAS commenting technique of enclosing the line with /* */ 
and add a similar line pointing to the desired WORK directory location: 
  
/* -WORK "!TEMP\SAS Temporary Files" */ 
-WORK "C:\SAS93 Temporary Files" 
 
Note, this is a perfect opportunity to place your WORK files on a larger or faster drive. Just knowing where the WORK 
files are located is helpful in cleaning up a hard drive after a SAS session has crashed. 
 
Save SASv9.CFG and close the Command Prompt window. Use Microsoft Windows Explorer to create the ‘C:\SAS93 
Temporary Files’ directory. Do this by viewing the contents of the C: root directory (C:\), right-click and choose New, 
then Folder, then enter SAS93 Temporary Files. The folder should appear under the C: root directory. 
 
Start regular SAS. If SAS does not start but a SAS Message Log window pops up, there was most likely an error in 
modifying the SASv9.CFG file. Once SAS starts, copy and submit this line of code in a blank SAS editor: 
 
libname  abc  (work) ; 
 
View the SAS Log to make sure the WORK directory is a subdirectory of C:\SAS93 Temporary Files. 
Close SAS without saving the program. Close the Command Prompt window if it was opened. 

EDIT OR CREATE AUTOEXEC PROGRAM FOR ENTERPRISE GUIDE – USEFUL FOR AN 
EXPERIENCED REGULAR SAS USER 
 
An AUTOEXEC program is like any other SAS program run from Enterprise Guide except that it runs automatically 
the first time an Enterprise Guide task is run or SAS data set is opened. If there is already an existing AUTOEXEC 
program for Enterprise Guide, the instructions in this section will differ slightly. If so, take note of these changes: 

 The AUTOEXEC filename and directory have already been chosen 
 Make a backup copy of the existing AUTOEXEC program before making these modifications 
 The SAS code below should be appended to the bottom of the existing AUTOEXEC program 

 
These instructions assume no AUTOEXEC program previously exists. 
 
Create a directory under the C: root directory called C:\ZAUTOEXEC using Microsoft Windows Explorer. Create 
another directory called CMD under the ZAUTOEXEC directory. Navigate to directory C:\ZAUTOEXEC\CMD. 
 
In ‘Folder and Search Options’ click on the View tab and uncheck ‘Hide extensions for known file types.’ Create a 
Command Prompt file by right-clinking in the C:\ZAUTOEXEC\CMD directory, and choosing New, then Text 
Document. Name it DIR_SAS.CMD. If a message stating that if you change a file name extension, the file might 
become unusable appears, click Yes that it should be changed. 
 
Right-click on DIR_SAS.CMD and choose Properties. Make sure the type of file is a Windows Command Script 
(.cmd) and not a Text Document (.txt). Note, sometimes Windows Explorer (and some editors) will try and rename the 
file to DIR_SAS.CMD.TXT. Edit DIR_SAS.CMD in Windows Notepad and copy in these commands: 
 
 



SAS Enterprise Guide and SAS, continued                                                                                                SESUG 2013 

 

3 
 

 
c: 
cd \zautoexec\cmd 
dir "c:\sas93 temporary files\_*" /b /o-d > workdir_sas.txt 
exit 
 
Make sure there is a single blank line after the EXIT line. Save and close the DIR_SAS.CMD file. 
 
At this point, directories C:\ZAUTOEXEC and C:\ZAUTOEXEC\CMD should exist and the Command Prompt file 
DIR_SAS.CMD should be in directory C:\ZAUTOEXEC\CMD. 
 
Start regular SAS. Copy this code into a blank SAS program editor window in regular SAS, and submit it, and check 
the SAS Log for errors: 
 
data a_sas; 
  n = 100000; 
  d = '01JAN2013'd; 
  format d date9.; 
run; 
 
Leave SAS running. Use Windows Explorer to navigate to C:\ZAUTOEXEC\CMD. Double-click DIR_SAS.CMD to run 
the Command Prompt file. Verify that file WORKDIR_SAS.TXT was created. 
 
If not, start a Command Prompt window and navigate to directory C:\ZAUTOEXEC\CMD. This can be accomplished 
by entering the first two lines of DIR_SAS.CMD above. Edit DIR_SAS.CMD and replace the EXIT line with PAUSE 
temporarily and rerun to troubleshoot. Do not forget to change PAUSE back to EXIT once it is working. Enter DIR to 
make sure file WORKDIR_SAS.TXT was created. 
 
Leave SAS running. Start Enterprise Guide. Copy this code into a blank SAS Program editor window in Enterprise 
Guide, and submit it: 
 
* regular SAS must be up and running before starting Enterprise Guide 
  for this code to work. If not, this logic will not work but that’s OK 
  if you just want to use Enterprise Guide on its own without this 
  functionality; 
 
* it seems backwards that this AUTOEXEC program for Enterprise Guide 
  mentions SAS so much, but remember the goal is to see the WORK 
  directory of regular SAS; 
 
%let saspath = c:\zautoexec\cmd; 
%let sascmd  = c:\zautoexec\cmd\dir_sas.cmd; 
 
x "&sascmd"; 
 
data dir1; 
  infile "&saspath\workdir_sas.txt" lrecl=300 length=len; 
  length dirname $ 16; 
  input @1 dirname $varying200.len; 
  if _n_ > 2 then delete; 
run; 
 
data _null_; 
  length saslib $ 59; 
  file "&saspath\dir_sas.sas"; 
  set dir1; 
  saslib = 'libname a_work "c:\sas93 temporary files\' || trim(dirname) || '";'; 
  put saslib; 
run; 
 
%include "&saspath\dir_sas.sas"; 
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To see if everything worked, check the Log window. If there were errors, try these troubleshooting steps: 

 Was regular SAS up and running before submitting this code? 
 Was WORKDIR_SAS.TXT read in correctly? If DIR_SAS.CMD runs successfully manually but not through 

the ‘x’ command be sure shelling out of Enterprise Guide even works. If not, a Registry entry may need to be 
changed. Contact SAS support. For now, the previous manual run of DIR_SAS.CMD will do. 

 Was DIR_SAS.SAS (not DIR_SAS.CMD) created correctly? Was it read in correctly? If not, troubleshoot 
those two steps. Try to open and submit DIR_SAS.SAS like a regular SAS program. 

 
Once the Log window has no errors, continue with these steps. From the Server List window in Enterprise Guide, 
expand Servers, then Local, then Libraries. There should be a SAS Library called A_WORK that contains a SAS data 
set called A_SAS. If not, some more troubleshooting is required. 
 
Save the Enterprise Guide code above as AUTOEXEC_EG.SAS in C:\ZAUTOEXEC (not C:\ZAUTOEXEC\CMD). 
Choose the Tools menu option in Enterprise Guide, then choose Options. Click SAS Programs, then select the 
checkbox titled ‘Submit SAS code when server is connected’, then click the Edit button next to it. Enter the following 
line below the INSERT CUSTOM CODE comment line: 
 
%include 'c:\zautoexec\autoexec_eg.sas'; 
 
Click Save, then OK. Note, there is another way of implementing an AUTOEXEC program in Enterprise Guide. There 
is an option under menu item Tools, Options, General, called ‘Automatically run Autoexec process flow when project 
opens.’ That method is not covered here. 
 
Leave regular SAS running. Stop Enterprise Guide. There is no need to save the project. Restart Enterprise Guide. 
From the Server List window, expand Servers, then Local, then Libraries. There should now be a SAS Library called 
A_WORK that contains a SAS data set called A_SAS. If not, some more troubleshooting is required. 
 
Leave regular SAS and Enterprise Guide running. 
 
Always test changes to any AUTOEXEC program before using any SAS product for development or production. 

SOME FUN STUFF IN ENTERPRISE GUIDE FOR EXPERIENCED REGULAR SAS USERS 
 
Now start counting. Open data set A_SAS in Enterprise Guide - this can be 1 or 2 double-clicks depending on how 
options are set. Click Send To. Click Microsoft Excel. Voila, just three or four clicks. Could that be any faster or 
easier? Close data set A_SAS. Note, choose menu option Tools, View Open Data Sets to see open data sets in 
Enterprise Guide. Locking issues can arise when trying to use a data set in regular SAS and Enterprise Guide 
simultaneously. Note, the 1 or 2 double-click sentence above refers to a setting in menu Tools, Options, Data 
General. It is the ‘Automatically open data when added to project’ option. If turned on, this can slow things down 
when adding large data sets to the project. 
 
Now, right-click on A_SAS in the Process Flow window and choose Query Builder. Click the Preview button to see 
the Preview Window and move it out of the way. Drag A_SAS to the Select Data tab window. Notice how Enterprise 
Guide builds the Structured Query Language (SQL) code automatically. This can be especially helpful for tables with 
many columns where not all columns are wanted. Tip: Enterprise Guide builds code in uppercase. If lowercase is 
preferred, before copying the code back to regular SAS, make a short detour through Microsoft Word. It has a button 
to do the conversion easily. Just take note of any quoted strings in the SQL. They should be kept from changing 
case. 
 
Double-click on column N in the Select Data tab window, then click the Change button. Click the Numeric Category, 
and then the COMMA format. Change the Overall width and Decimal places values and see how the changes affect 
the output on the fly. Set the overall width to 10 and the decimal places to 2. Click OK and OK. 
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Double-click on column D in the Select Data tab window, then click the Change button. Click the Date Category, and 
then the WORDDATE format. Change the Overall width and Decimal places values and see how the changes affect 
the output on the fly. Set the overall width to 18 and the decimal places to 0. Click OK and OK. 
 
Notice how the format logic is added to the SQL. Quite complex SQL code such as complicated WHERE filters and 
JOINs can be built in Enterprise Guide automatically. 
 
Close regular SAS and Enterprise Guide. 

EDIT OR CREATE AUTOEXEC PROGRAM FOR REGULAR SAS – USEFUL FOR AN EXPERIENCED 
ENTERPRISE GUIDE USER 
 
An AUTOEXEC program is like any other SAS program except that it automatically runs when regular SAS starts up. 
If there is already an existing AUTOEXEC program for regular SAS, the instructions in this section will differ slightly. If 
so, take note of these changes: 

 The AUTOEXEC filename and directory have already been chosen 
 Make a backup copy of the existing AUTOEXEC program before making these modifications 
 Modify the instructions and code below accordingly. Examples are: 

o Changes to the SAS icon (below) are not required 
o The code should be appended to the bottom of the existing AUTOEXEC program 

 
These instructions assume no AUTOEXEC program previously exists. 
 
Create a directory under the C: root directory called C:\ZAUTOEXEC (if it does not already exist) using Microsoft 
Windows Explorer. Create another directory called CMD under the ZAUTOEXEC directory (if it does not already 
exist). Navigate to directory C:\ZAUTOEXEC\CMD. 
 
In ‘Folder and Search Options’ click on the View tab and uncheck ‘Hide extensions for known file types.’ Create a 
Command Prompt file by right-clinking in the C:\ZAUTOEXEC\CMD directory, and choosing New, then Text 
Document. Name it DIR_EG.CMD. If a message stating that if you change a file name extension, the file might 
become unusable appears, click Yes that it should be changed. 
 
Right-click on DIR_EG.CMD and choose Properties. Make sure the type of file is a Windows Command Script (.cmd) 
and not a Text Document (.txt). Note, sometimes Windows Explorer (and some editors) will try and rename the file to 
DIR_EG.CMD.TXT. Edit DIR_EG.CMD in Windows Notepad and copy in these commands: 
 
c: 
cd \zautoexec\cmd 
dir "c:\sas93 temporary files\_*" /s /b /o-d > workdir_eg.txt 
exit 
 
Make sure there is a single blank line after the EXIT line. Save and close the DIR_EG.CMD file. 
 
At this point, directories C:\ZAUTOEXEC and C:\ZAUTOEXEC\CMD should exist and the Command Prompt file 
DIR_EG.CMD should be in directory C:\ZAUTOEXEC\CMD. 
 
Start Enterprise Guide. Copy this code into a blank SAS program editor window in Enterprise Guide, and submit it, 
and check the Log window for errors: 
 
data a_eg_temp; 
  n = 100000; 
  d = '01JAN2013'd; 
run; 
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The data set may be displayed automatically. If so, just close it. This should bring up the Process Flow window. 
Right-Click on A_EG_TEMP and choose Query Builder. Drag A_EG_TEMP to the Select Data tab window. Change 
the Output name (upper right corner) to WORK.A_EG. 
 
Double-click on column N in the Select Data tab window, then click the Change button. Click the Numeric Category, 
and then the COMMA format. Change the Overall width and Decimal places values and see how the changes affect 
the output on the fly. Set the overall width to 10 and the decimal places to 2. Click OK and OK. 
 
Double-click on column D in the Select Data tab window, then click the Change button. Click the Date Category, and 
then the WORDDATE format. Change the Overall width and Decimal places values and see how the changes affect 
the output on the fly. Set the overall width to 18 and the decimal places to 0. Click OK and OK. 
 
Choose Run to run the Enterprise Guide Task. The data set may be displayed automatically. If so, just close it. This 
should bring up the Process Flow window. 
 
Leave Enterprise Guide running. Use Windows Explorer to navigate to C:\ZAUTOEXEC\CMD. Double-click 
DIR_EG.CMD to run the Command Prompt file. Verify that file WORKDIR_EG.TXT was created. 
 
If not, start a Command Prompt window and navigate to directory C:\ZAUTOEXEC\CMD. This can be accomplished 
by entering the first two lines of DIR_EG.CMD above. Edit DIR_EG.CMD and replace the EXIT line with PAUSE 
temporarily and rerun to troubleshoot. Do not forget to change PAUSE back to EXIT once it is working. Enter DIR to 
make sure file WORKDIR_EG.TXT was created. 
 
Leave Enterprise Guide running. Start regular SAS. Note, there are warnings in the SAS Log. This is due to both EG 
and SAS trying to use the same SAS profile. If either cannot obtain exclusive use of the SAS profile one will get 
created in the WORK directory. This may or may not be a problem depending upon whether you have customized the 
look of the SAS windows or buttons or stored data sets in the SASUSER library. There are ways to set up different 
SAS profiles for SAS and EG, but they are outside the scope of this paper. 
 
Copy this code into a blank SAS editor window in regular SAS and submit it: 
 
* Enterprise Guide's local server must be up and running before starting SAS 
  for this code to work. If not, this logic will not work but that’s OK 
  if you just want to use SAS on its own without this functionality; 
 
* it seems backwards that this AUTOEXEC program for SAS mentions 
  Enterprise Guide so much, but remember the goal is to see the WORK 
  directory of Enterprise Guide; 
 
%let egpath = c:\zautoexec\cmd; 
%let egcmd  = c:\zautoexec\cmd\dir_eg.cmd; 
 
x "&egcmd"; 
 
data dir1; 
  infile "&egpath\workdir_eg.txt" lrecl=300 length=len; 
  length dirname $ 80; 
  input @1 dirname $varying200.len; 
  n = _n_; 
run; 
 
proc sql; 
  create table dir2 as 
  select * 
  from dir1 
  where index(dirname,'Prc2') > 0 
  order by n 
; quit; 
 
data dir3; 
  set dir2; 
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  if _n_ > 1 then delete; 
  dirname = substr(dirname,5); 
  dirname = substr(dirname,index(dirname,'\')+1); 
  dirname = substr(dirname,1,index(dirname,'\')-1); 
run; 
 
data _null_; 
  length saslib $ 70; 
  file "&egpath\dir_eg.sas"; 
  set dir3; 
  saslib = 'libname a_work "c:\sas93 temporary files\' || trim(dirname) || '\Prc2";'; 
  put saslib; 
run; 
 
%include "&egpath\dir_eg.sas"; 
 
To see if everything worked, check the SAS Log window. If there were errors, try these troubleshooting steps: 

 Was Enterprise Guide’s local server up and running before submitting this code (meaning an Enterprise 
Guide task had been run or a data set had been viewed)? 

 Was WORKDIR_EG.TXT read in correctly? If DIR_EG.CMD runs successfully manually but not through the 
‘x’ command be sure shelling out of SAS even works. If not, something may need to be changed. Contact 
SAS support. For now, the previous manual run of DIR_EG.CMD will do. 

 Was DIR_EG.SAS (not DIR_EG.CMD) created correctly? Was it read in correctly? If not, troubleshoot those 
two steps. Try to open and submit DIR_EG.SAS like a regular SAS program. 

 
Once the SAS Log window has no errors, continue with these steps. From the SAS Explorer window in regular SAS 
look for a SAS Library called A_WORK that contains a SAS data set called A_EG. If it is not there, some more 
troubleshooting is required. 
 
Save the SAS code above as AUTOEXEC_SAS.SAS in C:\ZAUTOEXEC (not C:\ZAUTOEXEC\CMD) and close 
regular SAS. Leave Enterprise Guide running. 
 
Make a backup SAS icon by: 

 If a SAS icon already exists on the desktop, right-click and hold and drag it a ways and drop it and click 
Copy 

 If a SAS icon does not already exist on the desktop, right-click and hold the SAS icon under All Programs, 
SAS, and drag it to the desktop and drop it and click Copy 

It may be preferable to keep an unmodified SAS icon in addition to the one set up to run the AUTOEXEC program. 
 
Right-click on the SAS icon that will use the AUTOEXEC program and choose Properties. Click in the Target box and 
hit the End key to navigate to the end of the text string. Place the following text at the end of the existing text string. 
Make sure a space precedes the new text below and then click OK to save the SAS icon properties. 
 
-autoexec 'C:\zautoexec\autoexec_sas.sas' 
 
Start regular SAS by clicking on the modified icon. If SAS does not start but a SAS Message Log window pops up or 
SAS starts and immediately shuts down, there was most likely an error in the SAS icon modification. If SAS starts up, 
check the SAS log for errors. If there are errors, open the AUTOEXEC_SAS.SAS program in the SAS editor and 
submit it to debug. 
 
From the SAS Explorer window in regular SAS look for a SAS Library called A_WORK that contains a SAS data set 
called A_EG. If it is not there, some more troubleshooting is required. 
 
Leave regular SAS and Enterprise Guide running. 
 
Always test changes to the AUTOEXEC program before using any SAS product for development or production. 
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SOME FUN STUFF IN REGULAR SAS FOR EXPERIENCED ENTERPRISE GUIDE USERS 
 
Double-click on the Query Builder icon in the Process Flow window in Enterprise Guide. Choose the CODE tab. 
Select and Copy these lines from the CODE tab window: 
 
PROC SQL; 
   CREATE TABLE WORK.A_EG AS  
   SELECT t1.n FORMAT=COMMA10.2,  
          t1.d FORMAT=WORDDATE18. 
      FROM WORK.A_EG_TEMP t1; 
QUIT; 
 
Then, paste them in a blank SAS editor window in regular SAS. Remember to take a short detour through Microsoft 
Word to change code to lowercase if desired. Make these changes: 

 Change WORK.A_EG_TEMP to A_WORK.A_EG_TEMP 
 Add  PROC PRINT; RUN; on a line by itself below the  QUIT; line 

Then, submit the code. 
 
Resize the Results Viewer window, the SAS Log window, and the SAS Editor window until all three are visible. 
In the SAS Editor window, change the format for: 

 Variable N (e.g. from FORMAT=COMMA10.2 to FORMAT=COMMA8.0) 

 Variable D (e.g. from FORMAT=WORDDATE18. to FORMAT=WORDDATE10.) 
Then, resubmit the code. Notice, all three windows are simultaneously visible and the Results Viewer window shows 
the outputs from this run and the previous run. That may be a good thing or a bad thing, but that is a discussion for 
another paper. Another topic for another paper is the fact that the button bar in regular SAS is highly customizable. 
This may be another reason an Enterprise Guide user might have an interest in using regular SAS. 
 
Close regular SAS and Enterprise Guide. 

FIRST WARNING 
 
Be sure to test these customizations thoroughly and know how to undo any changes here. Just like a SAS job or EG 
job will fail if you try to run the job while there is an exclusive lock on a data set the job needs, remember that also 
applies if the data set is being locked by the other product (i.e. SAS locking an EG WORK data set, or EG locking a 
SAS WORK data set). 

SECOND WARNING 
 
An automatic task that EG and SAS perform when they are shut down is to delete their WORK directories. If they 
crash this does not occur. If there are exclusive locks on WORK data sets this can also cause WORK directories to 
not get cleaned up. It is good practice to periodically check that old WORK directories are not hanging around. If so, 
you must delete them manually. On the bright side, now you know where to look for them. 

CONCLUSION 
 
Obviously, only the surface of regular SAS and Enterprise Guide’s capabilities were shown here, but submitting code 
in both products was covered. Hopefully having access to each other’s data will make it more convenient to switch 
back and forth between products. The bulk of the work is done in the WORK directories of each product. That is why 
considerable effort was made to share those directories with each other. 
 
Learning the strengths of each product can only make one’s productivity stronger. Also, if the advantages of one 
product over the other can be relayed to SAS, perhaps those features will wind up in future versions of the products. 
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